Chapter 318

Non-Inferiority Tests for Two Between Variances in a Replicated Design

Introduction

This procedure calculates power and sample size of tests of non-inferiority the between-subject variance (between + within) from a parallel (two-group) design with replicates (repeated measures) for the case when the ratio assumed by the null hypothesis is not necessarily one. This routine deals with the case in which the statistical hypotheses are expressed in terms of the ratio of the between-subject variances.

A parallel design is used to compare two treatment groups by comparing subjects receiving each treatment. In this replicated design, each subject is measured $M$ times where $M$ is at least two. To be clear, each subject receives only one treatment, but is measured repeatedly.

Replicated parallel designs such as this are popular because they allow the assessment of total variances, between-subject variances, and within-subject variances.

It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout period between measurements.

Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 209 - 212.

Suppose $x_{ijk}$ is the response of the $i$th treatment ($i = T, C$), $j$th subject ($j = 1, \ldots, Ni$), and $k$th replicate ($k = 1, \ldots, M$). The model analyzed in this procedure is

$$x_{ijk} = \mu_i + S_{ij} + e_{ijk}$$

where $\mu_i$ is the treatment effect, $S_{ij}$ is the random effect of the $j$th subject in the $i$th treatment, and $e_{ijk}$ is the within-subject error term which is normally distributed with mean 0 and variance $V_i = \sigma_{Wi}^2$. 
Non-Inferiority Tests for Two Between Variances in a Replicated Design

Unbiased estimates of these variances are given by

\[ \hat{\sigma}_{Wi}^2 = s_{Wi}^2 = \frac{1}{N_i(M - 1)} \sum_{j=1}^{N_i} \sum_{k=1}^{M} (x_{ijk} - \bar{x}_{ij})^2, \quad i = T, C \]

where

\[ \bar{x}_{ij} = \frac{1}{M} \sum_{k=1}^{M} x_{ijk} \]

Define

\[ s_{Bi}^2 = \frac{1}{N_i - 1} \sum_{j=1}^{N_i} (\bar{x}_{ij} - \bar{x}_{i.})^2 \]

where

\[ \bar{x}_{i.} = \frac{1}{N_i} \sum_{j=1}^{N_i} \bar{x}_{ij} \]

Now, estimators for the between-subject variance are given by

\[ \hat{\sigma}_{Bi}^2 = s_{Bi}^2 - \frac{1}{M} \hat{\sigma}_{Wi}^2 \]

**Testing Variance Non-Inferiority**

The following statistical hypotheses are used to test for between-subject variance non-inferiority.

\[ H_0: \frac{\sigma_{BT}^2}{\sigma_{BC}^2} \geq R0 \text{ versus } H_1: \frac{\sigma_{BT}^2}{\sigma_{BC}^2} < R0, \]

where \( R0 \) is the non-inferiority limit.

Let \( \eta = \sigma_{BT}^2 - R0(\sigma_{BC}^2) \) be the parameter of interest. The test statistic is \( \hat{\eta} = \hat{\sigma}_{BT}^2 - R0(\hat{\sigma}_{BC}^2) \).

**Non-Inferiority Test**

For the non-inferiority test, compute the limit \( \hat{\eta}_U \) using

\[ \hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U} \]

Reject the null hypothesis if \( \hat{\eta}_U < 0 \).

The \( \Delta \) is given by

\[ \Delta_U = h(1 - \alpha, N_T - 1)s_{BT}^4 + h(\alpha, N_C - 1)R_0^2s_{BC}^4 + h(\alpha, N_T(M - 1)) \left[ \frac{s_{WT}^2}{M} \right]^2 + h(1 - \alpha, N_C(M - 1)) \left[ \frac{R_0s_{WC}^2}{M} \right]^2 \]

where

\[ h(A, B) = \left( 1 - \frac{B}{X_{A,B}} \right)^2 \]

and \( X_{A,B}^2 \) is the upper quantile of the chi-square distribution with \( B \) degrees of freedom.
### Power

#### Non-Inferiority Test

The power of the non-inferiority test is given by

\[ \text{Power} = \Phi \left( \frac{z_\alpha - \frac{(R_1 - R_0)\sigma_{BC}^2}{\sqrt{\sigma^*^2/n}}}{\sqrt{\sigma^*^2/n}} \right) \]

where

\[ R_1 = \frac{\sigma_{BT}^2}{\sigma_{BC}^2} \]

\[ \sigma_{BT}^2 = R_1 \sigma_{BC}^2 \]

\[ \sigma^*^2 = 2 \left[ \left( \sigma_{BT}^2 + \frac{\sigma_{WT}^2}{M} \right)^2 + R_0^2 \left( \sigma_{BC}^2 + \frac{\sigma_{WC}^2}{M} \right)^2 + \frac{\sigma_{WT}^4}{M^2(M-1)} + \frac{R_0^2 \sigma_{WC}^4}{M^2(M-1)} \right] \]

where \( R_1 \) is the value of the variance ratio stated by the alternative hypothesis and \( \Phi(x) \) is the standard normal CDF.

A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary sample size.

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

#### Solve For

**Solve For**

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

#### Power and Alpha

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
Sample Size Per Group
The Sample Size Per Group is the number of items or individuals sampled in a group. Since the sample sizes are the same in each group, this value is the value for $N_f$ and $N_c$.

The Sample Size Per Group must be $\geq 2$. You can enter a single value or a series of values.

M (Measurements Per Subject)
Enter one or more values for M: the number of repeated measurements per subject. All measurements are for the same treatment.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is $M \geq 2$.

Effect Size
R0 (Non-Inferiority Variance Ratio)
Enter one or more values for the non-inferiority limit of the ratio of the two between-subject variances ($\sigma^2_{vt} / \sigma^2_{vc}$) assumed by the null hypothesis, H0. The sample variance ratio is compared to this value when conducting the test.

This value must be greater than one. Popular choices are 1.5 and 2.

R1 (Actual Variance Ratio)
Enter one or more values for the between-subject variance ratio assumed by the alternative hypothesis. This is the value of $\sigma^2_{vt} / \sigma^2_{vc}$ at which the power is calculated.

The range of possible values is $R1 > 0$. $R1 \neq R0$.

$\sigma^2_{vc}$ (Control Variance)
Enter one or more values for the between-subject variance of the control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{vc} > 0$.

$\sigma^2_{wt}$ (Treatment, Within-Subject Variance)
Enter one or more values for within-subject variance of the treatment measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{wt} > 0$.

$\sigma^2_{wc}$ (Control, Within-Subject Variance)
Enter one or more values for within-subject variance of the control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{wc} > 0$. 
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to show that it is non-inferior to the standard drug in terms of the between-subject variability. A two-group, parallel design will be used to test the non-inferiority.

Company researchers set the non-inferiority limit to 1.5, the significance level to 0.05, the power to 0.90, M to 2, and the actual variance ratio values between 0.8 and 1.3. They also set $\sigma^2_{bc} = 0.8$, $\sigma^2_{wt} = 0.2$, and $\sigma^2_{wc} = 0.3$. They want to investigate the range of required sample size values assuming that the two group sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Between Variances in a Replicated Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>2</td>
</tr>
<tr>
<td>R0 (Non-Inferiority Variance Ratio)</td>
<td>1.5</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.8 0.9 1.1 1.2 1.3</td>
</tr>
<tr>
<td>$\sigma^2_{bc}$ (Control Variance)</td>
<td>0.8</td>
</tr>
<tr>
<td>$\sigma^2_{wt}$ (Treatment Variance)</td>
<td>0.2</td>
</tr>
<tr>
<td>$\sigma^2_{wc}$ (Control Variance)</td>
<td>0.3</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

H0: $\sigma^2_{wt}/\sigma^2_{bc} \geq R0$ vs. H1: $\sigma^2_{wt}/\sigma^2_{bc} < R0$

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Grp T Sample Size</th>
<th>Grp C Sample Size</th>
<th>Num Reps</th>
<th>Non-Inf Var Ratio</th>
<th>Actual Var Ratio</th>
<th>Betw Subj Var Ratio</th>
<th>Wthn Subj Var Ratio</th>
<th>Wthn Subj Var Ratio</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9015</td>
<td>145</td>
<td>145</td>
<td>2</td>
<td>1.500</td>
<td>0.800</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9007</td>
<td>206</td>
<td>206</td>
<td>2</td>
<td>1.500</td>
<td>1.000</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9004</td>
<td>311</td>
<td>311</td>
<td>2</td>
<td>1.500</td>
<td>1.100</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9003</td>
<td>511</td>
<td>511</td>
<td>2</td>
<td>1.500</td>
<td>1.200</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9000</td>
<td>956</td>
<td>956</td>
<td>2</td>
<td>1.500</td>
<td>1.300</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9000</td>
<td>2269</td>
<td>2269</td>
<td>4538</td>
<td>2</td>
<td>1.500</td>
<td>1.300</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
</tr>
</tbody>
</table>

References


Report Definitions
Actual Power is the actual power achieved. Because \( N_t \) and \( N_c \) are discrete, this value is usually slightly larger than the target power. 
\( N_t \) is the number of subjects in the treatment group. 
\( N_c \) is the number of subjects in the control group. 
\( N \) is the total number of subjects. \( N = N_t + N_c \). 
\( M \) is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a subject. 
\( R_0 \) is the non-inferiority limit for the between-subject variance ratio. 
\( R_1 \) is the value of the between-subject variance ratio at which the power is calculated. 
\( \sigma^2_{ct} \) is the between-subject variance of measurements in the control group. Note that \( \sigma^2_{tc} = \sigma^2_{ct} + \sigma^2_{wc} \). 
\( \sigma^2_{wt} \) is the within-subject variance of measurements in the treatment group. 
\( \sigma^2_{wc} \) is the within-subject variance of measurements in the control group. 
\( \alpha \) is the probability of rejecting a true null hypothesis, \( H_0 \).

Summary Statements
A study is being conducted to assess the non-inferiority of the between-subject variance of a treatment group to a control group using a one-sided hypothesis test of data from a replicated parallel design. Group sample sizes of 145 and 145 achieve 90% power to reject the null hypothesis at a significance level of 0.050. The non-inferiority limit is 1.500. The variance ratio at which the power is calculated is 0.800. The number of times the measurement is repeated on a subject is 2. The actual between-subject variance of the control group is assumed to be 0.800. The actual within-subject variance of the treatment group is assumed to be 0.200. The actual within-subject variance of the control group is assumed to be 0.300.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and \( R_1 \).
Example 2 – Validation using Chow et al. (2018)

We will use an example from Chow et al. (2018) pages 212-213 to validate this procedure.

In this example, \( R_0 = 1.21 \), significance level = 0.05, power = 0.8, \( M = 3 \), \( R_1 = 0.5625 \), \( \sigma^2_{bc} = 0.16 \), \( \sigma^2_{wt} = 0.04 \), \( \sigma^2_{wc} = 0.09 \). The problem is to find the sample size. They find the per group sample size to be approximately 74.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Between Variances in a Replicated Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>3</td>
</tr>
<tr>
<td>R0 (Non-Inferiority Variance Ratio)</td>
<td>1.21</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.5625</td>
</tr>
<tr>
<td>( \sigma^2_{bc} ) (Control Variance)</td>
<td>0.16</td>
</tr>
<tr>
<td>( \sigma^2_{wt} ) (Treatment Variance)</td>
<td>0.04</td>
</tr>
<tr>
<td>( \sigma^2_{wc} ) (Control Variance)</td>
<td>0.09</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>H0: ( \sigma^2_{wt}/\sigma^2_{bc} \geq R_0 ) vs. H1: ( \sigma^2_{wt}/\sigma^2_{bc} &lt; R_0 )</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Num Reps</th>
<th>M</th>
<th>N</th>
<th>Non-Inf Var Ratio</th>
<th>Actual Var Ratio</th>
<th>R0</th>
<th>R1</th>
<th>\sigma^2_{bc}</th>
<th>\sigma^2_{wt}</th>
<th>\sigma^2_{wc}</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8044</td>
<td>150</td>
<td>3</td>
<td>75</td>
<td>1.210</td>
<td>0.563</td>
<td>0.160</td>
<td>0.040</td>
<td>0.090</td>
<td>0.050</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The sample size of 75 per group is close to their answer of 74. The difference occurs because of rounding. The sample size of 74 per group actually has a power slightly less than 0.8.